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Hands on Lab:  

Kentico Enterprise Marketing 

Solution: Campaigns 

Lab Overview 
System Requirements:  

 Kentico CMS 7 Enterprise Marketing Solution installed with the Sample 

Corporate Site 

Intended Lab Audience:  

 Online Marketers 

 CMS Designers 

Lab Introduction 
Executing successful campaigns is an essential part of any marketing organization. 

Campaigns are a way to engage and interact with your customers. They provide an ideal 

mechanism to generate sales leads and collect customer information. This set of 

exercises is intended to show the process of creating a document based campaign for 

the Services page that collects customer information using an online form.  Then using 

the collected customer information we will then score the leads for later use by the 

sales department. In completing this set of labs you will perform the following tasks: 

 Create an Online form for collecting customer information 

 Create a squeeze page for collecting customer information 

 Create a Services campaign 

 Create conversions  

 Create a lead score 
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 Optimize a campaign using A/B tests 

Lab 1: Creating an online form 
Online forms are the easiest way to create a contact information form for the live site 

without having to write application code. Forms are built using a data driven interface 

and then inserted into the page using the Online form web part.  In this lab we will 

create the contact information form and then insert it into the Services page, which is 

then used as the main campaign landing page.  

Lab 1-1: Creating an online form 

1. Log into CMS Desk and select the Tools tab and then click the Add a new form 

link as shown in the following screenshot. 
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2. In the New form dialog in the Form display name field enter Campaign Contacts 

and then click the Save button as shown in the following screenshot.  

 

 

3. In the Campaign Contacts form in the General tab update the following fields 

and then select Save. 

Section Field Value 

After the form is submitted Display text We will contact you shortly 

 Submit button text Submit 
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4. Select the Fields tab, click the Add new attribute (+) button, update the 

following fields and then click the Save button. 

Section Field Value 

Simple mode Column name First_name 

Simple mode Field caption First name 

Simple mode Field type Textbox 

Simple mode Maximum length 20 

 

5. Select the Add new attribute (+) button, update the following fields and then 

click the Save button. 

Section Field Value 

Simple mode Column name Last_name 

Simple mode Field caption Last name 

Simple mode Field type Textbox 

Simple mode Maximum length 30 
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6. Select the Add new attribute (+) button, update the following fields, and then 

click the Save button. 

Section Field Value 

Simple mode Column name Email_address 

Simple mode Field caption Email 

Simple mode Field type E-mail 

 
7. Select the Add new attribute (+) button, update the following fields, and the 

click the Save button. 

Section Field Value 

Simple mode Column name Contact_type 

Simple mode Field caption How can we help you? 

Simple mode Field type Drop-down list 

Editing control settings Type Options (one value; name 

pair on each line-example 

1;Blue) 

Editing control settings Data source Services;Services <CR> 

RFP; RFP 
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8. In the Fields tab validate the list of fields as shown in the following 

screenshot. 

 

 

9. Select the On-line marketing tab, click the Overwrite existing contact information 

with submitted data. If unchecked, only empty values of a contact are filled check 

box and then click the Save button as shown in the following screenshot. 
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10. In the On-line marketing tab update the following fields and then click the 

Save button 

Section Field Value 

General First name First_name 

General Last name Last_name 

Address E-mail Email_address 
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Lab 1-2: Inserting the online form  

1. In CMS Desk select the Content tab, in the Content tree select the Services page, 

then the Design tab, and in the Main zone select the Add web part icon (+) as 

shown in the following screenshot. 

 

 
2. In the Select web part screen select the Forms folder, the Online form web part 

and then Ok as shown in the following screenshot. 
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3. In the Web part properties (On-line form) update the following value. 

Section Field Value 

Bizform settings Form name Campaign_Contacts 

 
4. Select the Conversion tracking tab and then click the New button as shown in the 

following screenshot. 

 

What is a conversion? 

Conversions are specific actions performed by site visitors and recorded by the Web 

analytics module. This is typically done for specific events you want to track or as part of 

a broader campaign.  Once you start tracking conversions on the live site, these can be 

compared to other web analytics statistics like the amount of visitors. This allows you to 

evaluate the website and adjust marketing strategies as necessary.  
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5. In the New conversion screen in the Conversion display name field enter 

ContactInfo and then select Save& close as shown in the following screenshot.  

 

 
6. In the Web part properties (On-line form) screen in the Conversion value field enter 

20 and then select Ok as shown in the following screenshot. 
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7. Validate that you see the screen as shown in the following screenshot. 

 

 
8. In the upper right hand corner click the Sign out button as shown in the following 

screenshot.  

 

 

9. On the Live site select the Services page, update the online form with your 

contact information and select Submit as shown in the following screenshot. 

 



Kentico CMS Hands on Lab 
 

12 
 

10. Once the form is submitted validate that you see the following screenshot. 

 

 

11. Log into CMS Desk, select the Tools tab, then select Forms as shown in the 

following screenshot 
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12. In the Forms screen select the Edit icon (pencil) for Campaign Contacts as shown in 

the following screenshot. 

 

 

13. Validate that you see the data as shown in the following screenshot. 
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14. Click the On-line marketing tab, then select the Web analytics button, in the Web 

analytics list expand Campaigns & conversion, then expand Conversions and select 

Overview as shown in the following screenshot.  

 

 

15. Validate that you see a report similar to the following screenshot. 

 

 



Kentico CMS Hands on Lab 
 

15 
 

Lab 2: Creating the Services campaign 
Kentico EMS offers a variety of ways to create campaigns. Each is dependent on the type 

and purpose of your marketing strategy. With the completion of the online form we are 

now ready to create the document based campaign for the Services page. This campaign 

includes page visits to the Services page and completion of the online form.  

Lab 2-1: Create a document campaign 

1. Select the Content tab, in the Content tree select the Services page, then click the 

Analytics tab, Settings tab and in Track campaign select the New button as shown 

in the following screenshot. 
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2. In the New campaign dialog update the following fields and select Save & close. 

Section Field Property 

Campaign basic settings Campaign display name Services campaign 

Campaign basic settings Open from Now 

Campaign basic settings Open to Now + 2 weeks 

Advanced campaign settings Campaign impressions 20000 

Advanced campaign settings Total cost 10000 

 

3. In the Track conversion name click the New button as shown in the following 

screenshot. 
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4. In the New conversion dialog in the Conversion display name field enter Services 

page and then select Save & close as shown in the following screenshot.  

 

 
5. In the Conversion value field enter 10 and then select Save as shown in the 

following screenshot 

 

Why another conversion? 

The Services page campaign includes two tracked conversions. The first we created 

earlier with the online form. The Service page conversion tracks the traffic to the Services 

page.  
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Lab 2-2: Creating Campaign Data 

1. In the upper right hand corner click the Sign out button as shown in the following 

screenshot.  

 

 
2. On the Live site select the Services page as shown in the following screenshot. 

 

 

3. Log into CMS Desk, select the On-line marketing tab, and then the Web analytics 

button as shown in the following screenshot. 
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4. In the Web analytics list expand Campaigns & conversion, then expand Campaigns 

and then select the Overview report as shown in the following screenshot. 

 

 
5. In the Campaign drop down select the Services campaign and validate that you 

see a report similar to the following screenshot. 
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6. Select the Conversion count report as shown in the following screenshot. 

 

 
7. In the Campaign dropdown select the Services campaign, then in the Conversion 

dropdown select the Service page and validate that you see a report similar to 

the following screenshot. 
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Lab 3: Optimizing Campaigns with A/B testing 
As a campaign progresses it’s important to continually evaluate and refine. This can 

often include page elements like messaging and typography to find better ways to 

engage site visitors. In this lab we will create an A/B test of our services page as a way to 

increase our campaign conversions. Within Kentico EMS the first step is to create the 

A/B test and then create the variant page that will be used for the testing process. 

What’s the difference between A/B and MVT Testing?  

A/B testing is different than MVT Testing. An A/B test uses a combination of pages and 

tests elements like copy text, layouts, images and colors. MVT Testing is focused on web 

part zones, web parts, and widgets.  

Lab 3-1: Creating the A/B test 

1. Select the Content tab, in the Content tree select the Services page, select the 

Analytics tab, select the A/B tests tab and click the New test link as shown in the 

following screenshot 
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2. In the New test screen update the following fields and then select the Save 

button.  

Field Value 

Display name AB Services 

Target number of conversions 100 

Test from Now 

Test to  Now + 2 weeks 

Test enabled Checked 
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Lab 3-2: creating the variant page 

1. Select the New button as shown in the following screenshot. 

 

 
2. In the New document screen at the bottom select the A/B test page variant link as 

shown in the following screenshot. 

 

 

3. Update the following fields and then select the Save button. 

Field Value 

Document name AB_Services 

Assign to A/B test AB Services 
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4. Select the Page tab in the Editable region add the text This is the variant page and 

then select the Save button as shown in the following screenshot. 

 

 
5. In the Content tree select the Services page, then select the Analytics tab, then 

the A/B tests tab and for the AB Services test click the Edit (pencil) icon as shown 

in the following screenshot. 
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6. Select the Variants tab as shown in the following screenshot. 

 

What is this?  

The variants tab shows the current page variants that are included as part of the running 

AB Services test.  

7. In the upper right hand corner click the Sign out button as shown in the following 

screenshot.  
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8. On the Live site select the Services page as shown in the following screenshot 

 

It’s random! 

Remember the page received is random. Once you receive the Services page the cookie 

distributed to your machine will always open the same page. If you have a second 

browser available go ahead and try it!  
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Lab 4: Scoring contacts 
With the campaign running and proper demand generation our page will begin to 

receive site visits and contact form submissions. Once leads are collected they can be 

scored to show the weighting of their potential opportunities for our sales staff. In this 

lab we will enter our contact information and then create an Activity based scoring rule.  

Lab 4-1: Creating the contact 

1. From the Live site select the Services page, in the Contact form enter your contact 

information and click the Submit button as shown in the following screenshot 
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2. Log into CMS Desk as Administrator select the On-line marketing tab, click the 

Activities tab and validate that you see the form submission as shown in the 

following screenshot 

 

3. Select the Contacts tab and then select the Edit icon (pencil) as shown in the 

following screenshot 
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4. Validate that you see the Contact properties  as shown in the following 

screenshot 

 

 

Lab 4-2: Creating the scoring rules 

1. Click the Scoring button and then select the New score link as shown in the 

following screenshot. 
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2. In the New score screen in the Display name field enter Services and then click the 

Save button as shown in the following screenshot.  

 

 

3. In the General tab update the following fields and select the Save button. 

Field Value 

Send notification at score  20 

Notification e-mail address  Your email 

Why enter another score? 

When a contact score reaches the value of 20, a notification email is automatically 

generated to the email address specified.  
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4. Select the Rules tab and select the New rule link as shown in the following 

screenshot 

 

 

5. In the New rule screen update the following fields . 

Field Value 

Display name Campaign contacts 

Value 20 

Rule Type Activity 

What is the rule type? 

Rules are used to segment contacts for scoring. Kentico EMS supports two types of rules. 

Attribute based rules look for similarities in system values. Activity rules are based on the 

completion of a specific activity.  
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6. Update the following fields and then select the Save button. 

Section Field Value 

Rule Settings Activity Form Submission 

Activity details Form Campaign Contacts 

 
7. Select the General tab and click the Recalculate link as shown in the following 

screenshot 
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8. Click the Contacts tab and validate that you see your contact information as 

shown in the following screenshot 

 

Summary 
In this set of Hands on Labs we looked at how to create a campaign and collect 

customer information. We then looked at how we can optimize this campaign further 

with an A/B test. Specifically, we covered the following. 

 Creating an online form 

 Linking an online form to contacts with EMS 

 Creating a document campaign 

 Creating an A/B test  

 Collecting contact information 

 Scoring contacts 

Key Resources: 

 http://devnet.kentico.com/Documentation.aspx 

 http://devnet.kentico.com/Videos/ABTest.aspx 

http://devnet.kentico.com/Documentation.aspx
http://devnet.kentico.com/Videos/ABTest.aspx

